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Features

MPES-3D01 is a stereoscopic image processor software application designed 
specifically for use with the Multi Image Processor MPE-200.
The MPES-3D01 package comprises the following two software programs.
• SIP software

Stereoscopic image processing software to be installed on the MPE-200 unit.
This software allows you to correct alignment and color errors produced when 
capturing 3D images with two cameras, and provides a variety of monitoring 
methods for captured 3D images such as side-by-side viewing.

• SIP GUI software
Software to be installed on a computer that allows you to control stereoscopic 
image processing operations on the MPE-200 unit from the connected 
computer.

This manual explains how to install and use the MPES-3D01 software.

Besides this manual, please refer also to the MPE-200 OPERATION MANUAL 
(supplied with the MPE-200). 
Features
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Supported Stereo Camera Rigs

This software supports the following two types of stereo camera rigs.

• Half mirror type
Used mainly for close-up shooting. Allows easy adjustment of parallactic angle 
and toe-in angle and is therefore suitable for fine-tuning the appearance of the 
3D image.

In some installations, the left and right camera positions may be reversed.

• Side-by-side type
Suitable for distant-view shooting. In close-up shooting, the parallactic angle 
with this type of camera rig will be large, but in distant-view shooting, the angle 
is smaller and setup therefore is easier. Because the cameras can be fastened 
more securely, resulting in a stable installation, this type of rig is often used as 
center camera for relay broadcasting.

Tip

Right Camera

Left Camera

Right Camera Left Camera
7Features
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System Configuration Examples (Concept Diagram)

The SIP GUI software can control the stereoscopic image processing functions 
of the MPE-200 for up to three camera pairs (stereo cameras).

Controls stereoscopic image 
processing operation of the 
MPE-200.

SIP GUI software
(This software)

Network

Camera pairs 
(Stereo cameras)

Camera pairs 
(Stereo cameras)

Camera pairs 
(Stereo cameras)

SIP software

Computer

OUT 3 connector

Stereo 
monitoring display

Waveform 
monitoring display

Left Camera: 
IN 1 connector

OUT 4 connector

Right Camera: 
IN 2 connector

Stereoscopic Production 
Tool such as Production 
switcher or VTR

OUT 3 connector

Stereo 
monitoring display

Waveform 
monitoring display

Left Camera: 
IN 1 connector

OUT 4 connector

Right Camera: 
IN 2 connector

OUT 3 connector

Stereo 
monitoring display

Waveform 
monitoring display

Left Camera: 
IN 1 connector

OUT 4 connector

Right Camera: 
IN 2 connector

OUT 1 connector

OUT 2 connector

SIP software

OUT 1 connector

OUT 2 connector

SIP software

OUT 1 connector

OUT 2 connector

When using gen lock between 
devices, connect the gen lock 
video source to the REF IN 
connector on the MPE-200 unit.

Tip
Features
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Names and Functions of Parts

The pictures used in this guide may be different from the ones actually displayed and are subject to change without notice.

a File (in setup mode)
Click here to open the [File] menu. The [File] menu has the 
following commands.
New Setup: Serves for creating a new setup. 

(see page 69)
Reset to Default Values: This has the same effect as 

clicking all [Reset] buttons on the various tabs. 
Settings that have been locked will also be reset, 
except for certain settings.

Save Setup Data: Save the current settings as a setup 
file. (see page 70)

Manage Setup Files: Perform operations such as 
changing the system mode (see page 28) and deleting 
setup files (see page 71).

Configure Shot Box: Register or delete snapshot 
information in the Shot Box. (see page 83)

Restart this Processor: Restart the selected MPE-200 
unit. (see page 24)

Shutdown the System: Quit the SIP GUI software, and 
turn power to all connected MPE-200 units off. (see 
page 23)

Exit: Quit the SIP GUI software. (see page 23)

b Connect
Click here to open the [Connect] menu.
The [Connect] menu has the following commands.
Connect to Processors: Connect to the MPE-200 unit. 

(see page 26)
Disconnect this processor: Disconnect the selected 

MPE-200 unit (in setup mode). (see page 28)
Assign Processors: Assign a camera pair number to 

the MPE-200 unit. (see page 26)

c Help
Click here to open the [Help] menu.
The [Help] menu has the following commands.
About this software: Display version information for 

the SIP GUI software and the connected MPE-200 
unit.

Show System Message: Display system messages for 
the SIP GUI software and the connected MPE-200 
unit. When “System Message” appears on the 
waveform monitoring display, you can confirm the 
message with this command. The “System Message” 
display is grayed out after you confirm the message, 
and disappears after the problem is resolved.

1 2 53 4 6 7 9 q;8
9Names and Functions of Parts
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d Setup
Click here to switch to setup mode. A tabbed screen for 
making various settings appears. (see page 25)

e Shot Box
Click here to switch to shot box mode. The screen for 
controlling the shot box appears. (see page 84)

f Camera Pair 1 - 3
Click the number of the target camera pair for making 
settings and controlling operation.
The button color indicates the connection status to the SIP 
GUI software.

 : Connected and selected.

 : Connected but not selected.

 : Not connected.

For information on the correlation of camera pair 
numbers and MPE-200 unit, see the section “Assigning an 
MPE-200 Unit” (page 26).

g Tab (in setup mode)
Serves for making various settings.
[System] tab: Serves for making gen lock 

(synchronization) signal and camera preset settings 
and for viewing system mode information. (see page 
28)

[Camera Alignment] tab: Serves for providing 
correction for left/right camera alignment, roll shift, 
zoom shift, and other alignment errors, using digital 
signal processing technology. (see page 37)

[Color Correction] tab: Serves for ensuring color 
matching between left and right camera. (see page 47)

[Waveform Monitoring] tab: Serves to make settings 
for the waveform monitoring display function. (see 
page 53)

[Stereo Monitoring] tab: Serves to make settings for 
the function that enables stereo image alignment on 
the waveform monitoring display. (see page 60) 

[Convergence] tab: Allows tuning the appearance of 
the 3D image. (see page 72)

h WFM Lower Third
Sets the lower area of the waveform monitoring display to 
waveform display or depth information display. (see page 
56)

i Main Monitor / Lock
Sets the output format for the main monitor*. To lock this 
settings, place a check mark next to [Lock]. (see page 31)

* Stereo monitoring display connected to OUT 3 connector of MPE-200 
unit.

j Sub Monitor A/B / Zoom
Sets the output format for sub monitor A or sub monitor 
B*. To zoom the display, place a check mark next to 
[Zoom]. (see page 32)

* Virtual monitor on waveform monitoring display connected to OUT 4 
connector of MPE-200 unit.
Names and Functions of Parts
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Installing the SIP GUI Software on the Computer 

Install the latest version of Java on the computer to be used, and then install the 
SIP GUI software as follows.

SIP GUI Software Operation Environment

To use SIP GUI software, a computer meeting the following requirements is 
necessary.

Operating system (OS): 
Windows Vista, 32 bits, English Version, Service Pack 2
Windows 7, English Version
For details on other supported operating systems, please contact a 
Sony service representative or dealer.

Java: Version 6 Update 20
CPU: 1.6 GHz or higher
RAM: 2 GB or more
Graphics chip:

Intel or NVIDIA
HDD available space: 

500 MB or more
Monitor resolution:

1280 × 800 pixels or 1280 × 1024 pixels

Installing Java

Before using the SIP GUI software, the latest version of Java must be installed 
on the computer to be used.

1 Use your web browser to access “http://java.com./en/” and download the 
latest version of Java.

2 Follow the instructions on the web site to install the downloaded Java on 
your computer.
11Installing the SIP GUI Software on the Computer
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If there were no particular instructions when you obtained the SIP GUI 
software, install the latest version of Java.

Installing the SIP GUI Software

To install the SIP GUI software, log into your computer using an account with 
Administrator privileges.

If an older version of the SIP GUI software is installed on your computer, 
uninstall the SIP GUI software before installing the current version of the 
software.

For information on uninstallation, see “Uninstalling the Software” (page 15).

1 Obtain the installation package “MPES-3D01_****_install_package.zip.”

The file name will vary depending on the software version.

2 Unzip the ZIP file and copy the “SIP-GUI-****-setup.exe” file located in 
the “GUI” folder onto the desktop of your computer.

3 Double-click “SIP-GUI-****-setup.exe” to start the installation.

A security warning message appears.

4 Click [Run].

Note

Tip
Installing the SIP GUI Software on the Computer



  C
hapter 2  P

reparations
The installation preparation dialog box appears.

The following screen appears.

5 Click [Next].

The License Agreement screen appears.

6 Check the content of the agreement. If acceptable, click “I accept the terms 
in the license agreement.”

The following screen appears.
13Installing the SIP GUI Software on the Computer
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7 Specify the folder where the SIP GUI software should be installed, and click 
[Next].

To change the displayed folder, click [Change] and select a folder.
The default folder is “C:\Program Files\Sony\SIP.”

The following screen appears.

8 To proceed with the installation, click [Install].

The User Account Control confirmation screen of your operating system 
appears.
Installing the SIP GUI Software on the Computer
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9 Click [Allow].

The software installation starts.

When the installation is complete, the following screen appears.

10Click [Finish] to close the installer.

Verify that the “Stereo Image Processor” icon is shown on the desktop.

Uninstalling the Software

As with other applications, the SIP GUI software can also be uninstalled by 
using “Programs and Features” in the Control Panel. Select “Stereo Image 
Processor Software,” and then select [Uninstall/Change].  Follow the on-screen 
instructions to uninstall the software.
15Installing the SIP GUI Software on the Computer
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Preparations for the MPE-200 Unit

Connect the RS-232C port on the rear side of the MPE-200 unit to the serial port 
of the computer, using an RS-232C cable. Then use the terminal software of the 
computer to make the required settings for the MPE-200 unit.

Usage environment
RS-232C parameters: 

Serial port setting 
Rate 38,400 baud
Data word length 8 bit
Parity bit No
Stop bits 1 bit
Flow control No

Terminal settings: 
VT100 type, 80 character × 24 lines or more

Establishing communication: 
Confirm that “[syscon]$” appears on the terminal software.
Press the Esc key on the keyboard, and then press the Shift + C 
within 1 second. Next, press the Enter key a few times. “localhost 
login:” will appear and communication will start.

Logging in

To make settings, log in to the MPE-200 unit as a maintenance user account.

Maintenance user account information: 
username: setup
password: sjx-311

After login is completed, the management software starts up automatically and 
a console screen appears.

Regarding the following three items on the initial screen: 
- Application uninstall
- Factory Setting
- Platform update (may appear as “Management Utility update” depending 

on the software environment of the MPE-200 unit)
• These cannot be used when installing the MPES-3D01 software.
• For details on these functions, please contact a Sony service representative or 

dealer.

Tip
Preparations for the MPE-200 Unit
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Setting the Time Zone

Set the time zone as follows.
This example shows how to set the time for Japan.
The factory default setting is JST (Japan Standard Time).

1 On the initial screen, select “1.”

tzselect starts up.

2 Select “5) Asia” from the region selection.

3 Select “19) Japan” from the country selection.

The following information is displayed.

4 Verify that the setting is correct, and select “1) Yes .”

When the setting is complete, the initial screen returns again.

Setting the Clock

The internal clock of the MPE-200 is set at the factory, but the setting can be 
changed as follows if required.

1 On the initial screen, select “2.”

The current date and time are shown as follows.

2 Enter the date and time using the same format as above.

A confirmation message appears.

        Japan

Therefore TZ='Asia/Tokyo' will be used.

Local time is now:      Mon Oct  5 09: 06: 49 JST 2009.

Universal Time is now:  Mon Oct  5 00: 06: 49 UTC 2009.

Is the above information OK?

1) Yes

2) No

Clock adjust

----------------------------------------------------------

   2010-10-05 08: 57: 08
==>_

Clock adjust
----------------------------------------------------------
   2010-10-05 08: 57: 08
==>2011-01-23 09: 00: 00
17Preparations for the MPE-200 Unit
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3 Enter “y” and press the Enter key.

If you press the Enter key without any input, the following screen appears. 
To redo the input, enter “n.”

When the setting is complete, the initial screen returns again.

Making Network Settings

Make network settings as follows.
“eth0” refers to the NETWORK-1 connector on the rear of the MPE-200 unit.
“eth1” refers to the NETWORK-2 connector on the rear of the MPE-200 unit.
To configure a network with the computer on which the SIP GUI software is 
installed, either connector can be used.
The unit is shipped with preliminary settings for IP address and subnet mask. 
Change these settings as required for your network environment.

1 On the initial screen, select “3.”

2 Make network device settings as follows.

Example: Setting eth0 to “192.168.1.100”.

1Select “eth0.”
Use the arrow keys to move the cursor to “eth0” and press the Enter key. 

2Make “eth0” settings.
Enter the fixed IP address in the “Static IP” field, and enter the subnet 
mask in the “Netmask” field.

Make other settings as required.

The factory default settings are as follows.
Static IP: 192.168.0.2
Netmask: 255.255.255.0

Tip

Clock adjust
----------------------------------------------------------
   2010-10-05 08: 57: 08
==>
Cancel([y]es/[n]o)?_

+--------+ Network Configuration +--------+
|                                         |
|                                         |
| Name               eth0________________ |
| Device             eth0________________ |
| Use DHCP           [ ]                  |
| Static IP          192.168.1.100_______ |
| Netmask            255.255.255.0_______ |
| Default gateway IP ____________________ |
|                                         |
|      +----+             +--------+      |
|      | Ok |             | Cancel |      |
|      +----+             +--------+      |
|                                         |
|                                         |
+-----------------------------------------+

Tip
Preparations for the MPE-200 Unit
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3Use the arrow keys to move the cursor to “OK” and press the Enter key.

When the setting is complete, the initial screen returns again.

3 Reboot the MPE-200 unit. (see page 20)

Installing the SIP Software on the MPE-200 Unit

Copy the SIP software installation package to a USB memory for installation on 
the MPE-200 unit.
The SIP software will start and stop automatically along with startup and 
shutdown of the MPE-200 unit.

The installation package consists of the following files and folders, which are 
created when unzipping MPES-3D01_****_install_package.zip:
Depending on the software version, file names and number of files may be 
different.
• MPES-3D01-****.ppc64.rpm
• libpng-***-***.ppc64.rpm
• bzip2-libs-***-***.ppc64.rpm
• libicu-***-***.ppc64.rpm
• boost-***-***.ppc64.rpm
• repodata (folder)
• GUI (folder)

If multiple USB memory media are connected to the MPE-200 unit, the 
installation will not be carried out correctly. If another USB memory is 
connected to the MPE-200 unit, disconnect it.

1 Unzip the installation package and copy all files and folders to the root 
directory (topmost folder) of a USB memory media. Then connect the 
media to the MPE-200 unit.

2 On the initial screen, select “5.”

3 Select “1.MPES-3D01 "Sony Stereo Image Processor software" ****.”

A confirmation message appears.

4 Enter “y” and press the Enter key.

5 Enter the installation key that is provided with the installation package you 
obtained, and press the Enter key.

The installation key consists of 16 alphanumeric characters.
A confirmation message appears.

Tip

Note

Are you sure([y]es/[n]o)?_

Input the installation key code: _
19Preparations for the MPE-200 Unit
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6 Enter “y” and press the Enter key.

The installation starts.
When the installation is complete, the initial screen returns again.

7 Disconnect the USB memory media.

Completing the Setup Procedure

1 On the initial screen, select “q.”

The Quit screen appears.

2 On the Quit screen, select “r.”

The settings are confirmed and the MPE-200 unit reboots.

r:  Quit and Reboot
Preparations for the MPE-200 Unit
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Startup

Start the SIP GUI software by double-clicking the Stereo Image Processor icon 
on the desktop. The “Stereo Image Processor” window appears.
 

Immediately after startup, the MPE-200 unit is not yet connected, therefore the 
setting fields are still blank.
Next, connect to the MPE-200 unit. Proceed to “Connecting to the MPE-200 
Unit” (page 26).

• It is not possible to start several instances of this software simultaneously.
• Configure the network settings on your computer before starting this 

software.

Notes
21Startup
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When you start up the SIP GUI software, your computer's built-in firewall may 
display an alert dialog box that allows you to select whether Java will block 
incoming network connections to the computer. In such cases, select [Unblock]. 
This alert will not appear at future startups.

Tip
Startup
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Shutdown

Quitting the SIP GUI Software

To quit the SIP GUI software, you can use one of the following methods.
• Access the [File] menu and select [Exit].
• Click the [×] button in the right of corner on the title bar of the “Stereo Image 

Processor” window.

System Shutdown

By accessing the [File] menu and selecting “Shutdown the System,” you can 
quit the SIP GUI software and turn off power to all connected MPE-200 units.

Unless forced shutdown is necessary, do not use the power button on the front 
panel of the MPE-200 unit to shut down the system.

Note
23Shutdown
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Restarting a MPE-200 Unit

To restart the MPE-200 unit when the video format or other system mode 
settings were changed, proceed as follows.
The SIP GUI software and MPE-200 unit must be connected to perform this 
operation.

For information on connecting the MPE-200 unit, see “Connecting to the MPE-
200 Unit” (page 26).

1 Click [Setup] and click the camera pair number for the MPE-200 unit that 
you want to restart.

2 Access the [File] menu and select [Restart this Processor].

The MPE-200 unit is restarted.
Restarting a MPE-200 Unit
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Overview

This chapter describes how to make the following settings, which are required 
for correcting the stereoscopic image output from the camera pair or monitoring 
a waveform.
• Basic setup (page 26)
• Camera alignment correction (page 37)
• Left/right camera color matching (page 47)
• Selecting output signal format for waveform monitoring display (page 51)
• Configuring the stereo image alignment function (page 60) 

To make a setting, first click [Setup] to switch to setup mode.
25Overview
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Basic Setup

This section explains how to make the necessary settings for controlling 
stereoscopic image processing with the MPE-200 unit.

Assigning an MPE-200 Unit

Assign the MPE-200 unit to a camera pair number as follows.

1 Access the [Connect] menu and select [Assign Processors].

The “Assign Processors” dialog box appears.

2 Enter the IP address of the camera pair you want to assign in the 
[IP Address] field, and click [OK].

The MPE-200 unit is assigned to the camera pair number.

Do not assign the same IP address to multiple camera pairs. Otherwise 
system operation will become unstable.

Connecting to the MPE-200 Unit

First specify the MPE-200 unit to connect to, as described in “Assigning an 
MPE-200 Unit” (page 26).

1 Turn power to the MPE-200 unit on.

Verify that video is output by the MPE-200 unit.

2 Access the [Connect] menu and select [Connect to Processors].

The “Connect to Processors” dialog box appears.

Note
Basic Setup
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3 Click [Connect].

When the connection has been successfully established, the following 
message appears on the [Console].

4 Click [Close].

Information about the MPE-200 unit appears on the SIP GUI software, and 
control from this software is enabled.

Disable the sleep mode function of your computer’s operating system. If the 
function is enabled and the computer enters sleep mode during operations, 
communication with the MPE-200 units will be disconnected.

• If unsuccessful, the connection process to the MPE-200 unit will time out 
after a certain period.

• If connection to all assigned MPE-200 units failed, the  icon appears on 
this dialog box. If there was at least one MPE-200 unit to which 
connection failed, the  icon appears. Even if the  icon is shown, 
operation of other MPE-200 units for which the connection was 
successful is possible.

Note

Tips
27Basic Setup
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To disconnect a MPE-200 unit

1 Access the [Connect] menu and select [Disconnect this Processor].

The “Disconnect this Processor” dialog box appears.

2 Click [Disconnect].

The connection to the MPE-200 unit is disconnected.

3 Click [Close].

Changing the System Mode

The system mode can be changed by modifying the setup file used at startup.
The change will become effective when the MPE-200 unit is restarted.

You can display information about the current system mode by selecting 
[System Mode] under the [System] tab.

1 Click the camera pair number.

2 Access the [File] menu and select [Manage Setup Files].

The “Manage Setup Files” dialog box appears.

Tip
Basic Setup
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3 Select the setup file to use at startup and click “Set to Start Up.”

The file that will be used at startup is displayed with the indication “(start 
up)” after its name.

4 Access the [File] menu and select [Restart this Processor].

The MPE-200 unit is restarted.

5 Verify that video is being output from the MPE-200 unit.

6 Reconnect the MPE-200 unit. (see page 26)

Tip
29Basic Setup
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Setting the Monitor Output Format

This section describes how to set the output format for the main monitor* and 
sub monitor A/B** connected to the MPE-200 unit.
* Stereo monitoring display connected to OUT 3 connector of MPE-200 unit.
**Virtual monitor on waveform monitoring display connected to OUT 4 connector of MPE-200 unit.

Display example

MPE-200 unit

OUT 3 connector OUT 4 connector

Main monitor
(Stereo monitoring display)

Sub monitor
(Waveform monitoring display)

Sub monitor A 
display

Sub monitor B 
display
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Setting the main monitor output format

1 Click the camera pair number.

2 In the [Main Monitor] window at the top right of the screen, select the image 
signal output format for the main monitor.

The following settings are available.
Side by Side: The left half of the screen is made up by the L image signal, 

and the right half by the R image signal. Both L and R are compressed 
to 1/2 size in the horizontal direction.

Above Below: The top half of the screen is made up by the L image signal, 
and the bottom half by the R image signal. Both L and R are compressed 
to 1/2 size in the vertical direction.

Left Only: Only the L image signal is output.
Right Only: Only the R image signal is output.
Anaglyph: Old-style output which gives a stereoscopic image when using 

glasses with red and blue filters.
50% Mix: L and R image signals are mixed at 50% each.
Difference: Parts where the L and R image signals match are represented 

in gray, and non-matching parts are output with the original color and 
luminance.

Difference Y: Compares the luminance of the L and R image signals. Parts 
where the brightness signal matches are shown in gray. Parts where the 
brightness is different are shown in black and white, according to the 
degree of difference.

Checkerboard: L and R image signals are output alternately in a 
checkerboard pattern.

Split Screen: The output is switched partway, so that the left half of the 
screen is made up by the L image signal, and the right half by the R 
image signal. 

Default setting: Side by Side

3 To lock the settings, place a check mark next to [Lock].

1 2 3
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Setting the sub monitor A/B output format
The same format is used both for sub monitor A and sub monitor B.

1 Click the camera pair number.

2 In the [Sub Monitor A] window or the [Sub Monitor B] window at the top 
right of the screen, select the image signal output format for the sub monitor.

The following settings are available.
Anaglyph: Old-style output which gives a stereoscopic image when using 

glasses with red and blue filters.
50% Mix: L and R image signals are mixed at 50% each.
Difference: Parts where the L and R image signals match are represented 

in gray, and non-matching parts are output with the original color and 
luminance.

Difference Y: Compares the luminance of the L and R image signals. Parts 
where the brightness signal matches are shown in gray. Parts where the 
brightness is different are shown in black and white, according to the 
degree of difference.

Checkerboard: L and R image signals are output alternately in a 
checkerboard pattern.

Split Screen: The output is switched partway, so that the left half of the 
screen is made up by the L image signal, and the right half by the R 
image signal.

Default settings: 
Sub Monitor A: Anaglyph
Sub Monitor B: 50% Mix

3 To display the image at the same zoom ratio as the left/right camera zoom 
selected for the waveform monitoring display, place a check mark next to 
[Zoom].

1 2 3
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Setting Camera Preset Information

1 Click the camera pair number.

2 Display the [System] tab.

3 Set the following items under [Preset Focal Length].

When an item is changed, the settings are stored and become effective 
immediately.

The settings for [Zoom Position 1] and [Zoom Position 2] are used when 
[Position 1] or [Position 2] is clicked for [Focal Length] under the [Camera 
Alignment] and [Convergence] tab.

1

2

3

Setting item Setting range Default 
setting

Description

Camera Type Manual, 
Generic 1/2 inch, 
Generic 2/3 inch

Manual Selects the sensor size. 

Sensor Size (mm) 0.01 mm - 9.99 mm 4.00 mm When [Camera Type] set 
to [Manual], the sensor 
size can be input here. 
The setting is fixed to 
“4.00” when [Camera 
Type] is set to [Generic 
1/2 inch], and to “5.40” 
when [Camera Type] is 
set to [Generic 2/3 inch]. 

Zoom Position 1 (mm) 0.1 mm - 500.0 mm 5.8 mm Enter the zoom position. 

Zoom Position 2 (mm) 0.1 mm - 500.0 mm 81.2 mm Enter the zoom position. 

Tip
33Basic Setup
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Selecting the Gen Lock Signal

Select a gen lock signal for controlling the timing of stereo image processing at 
the MPE-200 unit.
The gen lock setting will become effective when the MPE-200 unit is restarted.

1 Click the camera pair number.

2 Display the [System] tab.

3 In the [Signal Source] drop-down box under [Gen. Lock], select the video 
input signal to which the MPE-200 should be synchronized.

Ref. Video: Synchronize the video signal that is input from the REF IN 
connector on the rear of the MPE-200 unit.

For information on the reference signals that can be input in each 
system mode, see page 67.

HD SDI (Input 1): Synchronize the video signal that is input from the IN 
1 connector on the rear of the MPE-200 unit.

Default setting: 
HD SDI (Input 1)

4 Access the [File] menu and select [Save Setup Data] to store the setting.

For information on the setting procedure, see “Saving the Current Settings 
as a Setup File” (page 70).

5 Access the [File] menu and select [Restart this Processor].

The MPE-200 unit is restarted.

6 Verify that video is being output from the MPE-200 unit.

7 Reconnect the MPE-200 unit. (see page 26)

1

2

3

4, 5
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• Make sure that the signal selected in [Signal Source] is input during use. If the 
signal source is temporarily disrupted or changed, be sure to establish the Gen. 
Lock phase by selecting [Restart this Processor] from the [File] menu again, 
and restarting the MPE-200 unit.

• When reference signals other than those that are supported (see page 67) are 
input, an error message may not appear, even if you enable system message 
display for the MPE-200 unit with the [Show System Message] setting (see 
page 9).

Selecting the Video Signal Processing Pattern of the MPE-200 Unit

You can select how the MPE-200 should process the video signals supplied to 
the IN connectors on the MPE-200 unit.

1 Click the camera pair number.

2 Display the [System] tab.

3 Use the [Mode] item of the [Input Selector] to select the video signal 
processing pattern to be used by MPE-200 unit.

Default: The L and R camera signals input to the IN 1 and IN 2 connectors 
are processed separately.

Clone: The camera signal input to the IN 1 connector is used for both L and 
R.

Side by Side: The side by side type video signal input to the IN 1 
connector is separated into L and R.

Default setting: Default

The selection is reflected immediately on all video outputs.

Notes

1

2

3
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Checking a 3D Mouse

When a functional 3D mouse is connected, you can check its type and available 
functions as follows.
For information on 3D mouse types that can be used with the SIP GUI software, 
please contact a Sony service representative or dealer.

1 Click the camera pair number.

2 Display the [System] tab.

3 Check [3D Mouse] under [Detected Device] to see whether a 3D mouse has 
been detected.

If a 3D mouse has been detected, its name will be displayed.
If no 3D mouse has been detected, the indication “None” will be shown.

When a 3D mouse supported by the SPI GUI software has been detected, 
functions that can be used will be listed under [Assignment].

Connect the 3D mouse before starting the SIP GUI software.

1

2

3

Note
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Camera Alignment Correction

You can provide correction for left/right camera optical axis shift, alignment, 
roll shift, and other alignment errors, using digital signal processing technology. 
You can also select the image flip method to use for images shot with a half 
mirror type camera rig.
To assess these settings, click the [Camera Alignment] tab.

Basic Operations Under the [Camera Alignment] Tab

Correction settings can be made for the left and right camera separately.
The preview area allows you to check the effect of settings.

Selects the camera pair for which to make settings.

Panel for left camera settings Panel for right camera settings

View area
37Camera Alignment Correction
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Using the view area

a Focal Length
Read the focal length from the zoom ring of the camera in use and set this value.
When you click [Position 1] or [Position 2], the focal length specified with 
[Zoom Position 1] and [Zoom Position 2] under the [System] tab is set in the 
input field.
To enter a focal length other than the preset values, enter a numeric value in the 
range from 0.1 mm to 500.0 mm.

If the [Toe-In Angle] setting of [Convergence] in the [Convergence] tab, or any 
one of the [Translate X], [Translate Y], [Tilt], or [Toe-In] settings in the 
[Camera Alignment] tab are set to a value other than the default value of 0, the 
value configured here will have an effect on the output results.

b Zoom Link
Using the focal length information obtained from the camera, the camera 
alignment can be corrected automatically according to the zoom setting.

• When a check mark is placed next to [Zoom Link], the numeric value input 
for 1 [Focal Length] has no effect. When the [Zoom Link] check mark is 
removed, the most recently obtained focal length value will be entered as 
[Focal Length].

• Placing a check mark next to [Auto Offset] or [Auto Scale] in the 
[Convergence] tab will also activate a check mark next to [Zoom Link]. When 
the [Zoom Link] check mark is removed, the [Auto Offset] and [Auto Scale] 
check marks will also be removed automatically.

• For information on lenses and cameras supporting the Zoom Link function, 
please contact a Sony service representative or dealer.

c Auto Size
When performing camera alignment, it may happen that a section without image 
(blanking section) becomes visible. This function provides enlargement so that 
the blanking section will not be shown.
Size correction will be performed automatically, and the correction ratio can be 
viewed in the value box.
When the parameters for the left (right) camera are changed, the image from the 
other camera may also be affected.

1 2 3

5

Top View Side View Rear View

4

Tip

Tips
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d Manual Size
Allows manual size correction.
When you have selected this option, enter a ratio between 0.010 and 5.000.
Default setting: 1.000

e View area
There are three angles provided by the camera model: Top View, Side View, 
and Rear View. (The indication from left is Top View, Side View, Rear View.) 
The view area makes it possible to check how the various parameter setting 
values affect the respective camera model. If you place a check mark next to 
[Zoom Link], the affect is not reflected. The degree of change is about three 
times the actual setting. 

Locking the correction setting
By placing a check mark next to [Lock], you can lock the current correction 
value.
Locking is possible for the left and right camera separately.

The locking feature allows you to protect certain settings from being changed 
inadvertently. Information about whether a setting is locked is not stored in the 
setup file.
Even when locked, executing [Reset to Default Values] will return settings to 
their default value, except for certain settings.

Returning the correction setting to the default
Clicking the [Reset] button for the left or right camera will return the correction 
setting to the default value.

Tip

Left camera locked Right camera locked
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Selecting the Flip Setting for a Mirror Rig

When using a half mirror type camera rig, the appropriate setting can be selected 
here to reverse the mirrored image.
Select the [Image Flip] setting for the left and right camera. Available choices 
are listed below.

Normal: No image reversal.
Vertical Flip: The image is reversed in the vertical direction (top to bottom).
Horizontal Flip: The image is reversed in the horizontal direction (side to 

side).
Flip Both V&H: The image is reversed both in the vertical and horizontal 

direction.

Default setting: Normal

Correcting Optical Axis Shift

Optical axis shift for the left and right camera can be corrected as follows.

To make the correction setting, use the [Optical Axis Adjustment] field for the 
left and right camera. You can either move the slider sideways or enter a 
numeric value.

* Number of lines in frame

Setting item Setting range Default 
setting

Description

Planar Shift H –99.99 pixels to 
+99.99 pixels

0.00 
pixels

Enter the value for 
horizontal planar shift. 

Planar Shift V –99.99 lines* to 
+99.99 lines* 

0.00 
lines* 

Enter the value for 
vertical planar shift. 

CCD Planar Shft V

Planar Shft H
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Optical Axis Position Search
Search for the point (optical axis) where the image does not shift when the 
display range is extended from the wide end to the zoom end.
To enable optical axis searching, determine distinctive points (feature points) 
within the image, and register their positions in pairs for wide display and zoom 
display.

1 Click [Reset] for the camera you want to adjust to reset its [Optical Axis 
Adjustment] parameters.

2 Click [Assist] under [Optical Axis Adjustment] for the camera you want to 
adjust.

The “Optical Axis Adjustment Assist” dialog box appears.
In the “Optical Axis Adjustment Assist” dialog box, register mark points for 
[Zoom Size A] and [Zoom Size B] and specify two to four pairs for 
calculating the optical axis position.

3 Click a Mark Points button for Size A to activate it.

4 Operate the camera and select the Zoom configuration.

Adjust camera zoom to obtain at least two points that provide good zooming 
and can be marked.
This Zoom condition is defined as Size A.

5 Enter numeric values for [Size] in [Zoom Area] to adjust the size so that the 
markers are visible.

3

7, 13

6, 12

5,
11

16 17 18

9
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For increased marking precision, a [Size] value of around 10 is 
recommended.

After starting to specify markers for Size A, do not change the [Size] setting. 
If the [Size] value is changed during the process, calculation will not be 
performed correctly.

6 Drag the crosshair cursor (dotted lines) or enter numeric values for [H] and 
[V] to specify the mark points.
 

* This setting range is not supported in the current version of this software.

7 Click [Mark].

The mark point is registered.
When a mark point has been registered, a cross-shaped marker is shown in 
the waveform area of the waveform monitoring display.

Activation of the Mark Points buttons moves to the next button.

8 Repeat steps 6 to 7 to register mark points 2 to 4.

Next, make the [Zoom Size B] setting.

9 Click a Mark Points button for Size B to activate it.

10Operate the camera and select the Wide configuration.

Adjust the camera to obtain at least two points that provide a wide angle and 
can be marked.
This Wide condition is defined as Size B.

Setting item Setting range Default 
setting

Description

Size 1 to 100 25 Adjust the size of the zoom area. 
Use this setting for small 
images, for example.

Tip

Note

Setting item Setting range Default 
setting

Description

H –234 to +234 0 Enter the position value 
on the horizontal axis.

–156 to +156* 

V –129 to +129 0 Enter the position value 
on the vertical axis.

–86 to +86* 

Size A mark points

Waveform area display example
Camera Alignment Correction
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11Enter numeric values for [Size] in [Zoom Area] to adjust the size so that the 
markers are visible.

For increased marking precision, a [Size] value of around 7 is 
recommended.

After starting to specify markers for Size B, do not change the [Size] setting. 
If the [Size] value is changed during the process, calculation will not be 
performed correctly.

12Drag the crosshair cursor (dotted lines) or enter numeric values for [H] and 
[V] to specify the mark points.

13Click [Mark].

14Repeat steps 12 to 13 to register two to four mark points.

15Verify that there are two to four pairs for [Zoom Size A] and [Zoom Size B].

16Click [Calculate].

The optical axis position is calculated.

• Each feature point must be registered to the same Point number under Size 
A and Size B.

• When two or more mark point pairs have been set, the [Calculate] button 
becomes available.

• To clear mark point information, click the button with the respective 
number so that the button is active, and then click [Clear].

• To clear all mark point information for [Zoom Size A] and [Zoom Size 
B], click [All Clear].

• While the “Optical Axis Adjustment Assist” dialog box is shown, the 
following conditions are established temporarily.
-  Waveform Area region display is off.
-  Parameters under the [Camera Alignment] tab and [Convergence] tab 

which may affect [Optical Axis Adjustment] are taken as being set to 
the default values.

• After start marking for Size B, the mark points registered for Size A never 
follow distinctive points.

Tip

Note

Tips

Size B mark points

Waveform area display example

The mark point configured for Size A 
is also displayed as a reference.
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17Click [Apply].

The adjustment values are reflected in [Planar Shift H] and [Planar Shift V] 
of [Optical Axis Adjustment].

To redo the adjustment, click [All Clear] and repeat steps 3 to 17.

18When the adjustment is complete, click [Close].

The “Optical Axis Adjustment Assist” dialog box closes.

When the dialog box closes, all mark point data are cleared.

Correcting Position Shift

Position shift for the left and right camera can be corrected as follows.

To make the correction setting, use the [Camera Position Adjustment] field for 
the left and right camera. You can either move the slider sideways or enter a 
numeric value.

Moving [Translate Z] in the negative direction enlarges the image, but at a 
certain point, the image will become black.

Tip

Values are reflected here.

Setting item Setting range Default 
setting

Description

Translate X –9.999 to +9.999 0.000 Enter the value for X axis 
correction. 

Translate Y –9.999 to +9.999 0.000 Enter the value for Y axis 
correction. 

Translate Z –9.999 to +9.999 0.000 Enter the value for Z axis 
correction. 

Tip

Translate X Translate Y Translate Z
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Correcting Roll Shift

Toe-in angle shift and roll shift for the left and right camera can be corrected as 
follows.

To make the correction setting, use the [Camera Rotation Adjustment] field for 
the left and right camera. You can either move the slider sideways or enter a 
numeric value.

 
Setting item Setting range Default 

setting
Description

Toe-In –9.999 degrees to 
+9.999 degrees

0.000 
degrees

Enter the value for toe-in 
angle correction. 

Tilt –9.999 degrees to 
+9.999 degrees

0.000 
degrees

Enter the value for tilt 
correction. 

Roll –9.999 degrees to 
+9.999 degrees

0.000 
degrees

Enter the value for roll 
correction. 

Toe-In

Roll

Tilt

Toe-in angle shift Roll shift

Tilt shift
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Keystone Correction

You can provide correction for a 3D image that has keystone distortion.
To make the setting, use the [Keystone Adjustment] field for the left and right 
camera. You can either move the slider sideways or enter a numeric value.

 
Setting item Setting range Default 

setting
Description

Keystone H –20.00 degrees to 
+20.00 degrees

0.00 
degrees

Enter the value for 
horizontal keystone 
correction. 

Keystone V –20.00 degrees to 
+20.00 degrees

0.00 
degrees

Enter the value for 
vertical keystone 
correction. 
Camera Alignment Correction
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Color Matching for Left and Right Camera

You can adjust the white balance, black balance, and gamma curve values to 
achieve color matching for the image from the left and right camera. For images 
shot with a half mirror type camera rig, the signal level can also be adjusted to 
correct the attenuation caused by the half mirror.
The settings for color matching are located under the [Color Correction] tab.

Basic Operations Under the [Color Correction] Tab

Correction settings can be made for the left and right camera separately.

Enabling the color correction function
Placing a check mark next to [CCR] enables the color correction function, 
allowing you to adjust the white balance, black balance, gamma, and knee 
values.
The enable/disable setting is made separately for the left and right camera.

Selects the camera pair for which to make settings.

Panel for left camera settings Panel for right camera settings

Enable function for left camera Enable function for right camera
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Locking the correction settings
By placing a check mark next to [Lock], you can lock the current correction 
values.
Locking is possible for the left and right camera separately.

The [Lock] function is only intended to prevent accidental changing of 
configured settings. Information regarding whether this function is enabled is 
not saved to setup files. When you execute [Reset to Default Values], the 
settings will return to default values regardless of whether the lock function is 
enabled.

Returning the correction settings to the default
You can either return a specific correction setting or all correction settings to the 
default values.

Returning a specific correction setting to the default
Click [Reset] in the respective setting panel.
Screen example: White Color Adjustment

Returning all correction settings to the default
Click [Reset] in the top right of the camera operation area for the left and right 
camera.

Adjusting the White Balance

You can control the white balance for the left and right camera by adjusting the 
Red/Green/Blue/Master values.

To make the setting, use the [White Color Adjustment] field for the left and right 
camera. You can either move the slider sideways or enter a numeric value.

Tip

Left camera locked Right camera locked
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Adjusting the Black Balance

You can control the black balance for the left and right camera by adjusting the 
Red/Green/Blue/Master values.

To make the setting, use the [Black Color Adjustment] field for the left and right 
camera. You can either move the slider sideways or enter a numeric value.

 

Adjusting the Gamma Curve

You can control the gamma curve and the knee point of the gamma curve for the 
left and right camera by adjusting the Red/Green/Blue/Master values.
The relationship between the gamma and the knee is as follows.

Setting item Setting range Default 
setting

Description

Red 0.0 to +200.0 +100.0 Enter the value for Red 
adjustment. 

Green 0.0 to +200.0 +100.0 Enter the value for Green 
adjustment. 

Blue 0.0 to +200.0 +100.0 Enter the value for Blue 
adjustment. 

Master 0.0 to +200.0 +100.0 Enter the value for linked 
Red, Green, and Blue 
adjustment.

Setting item Setting range Default 
setting

Description

Red –100.0 to +100.0 0.0 Enter the value for Red 
adjustment. 

Green –100.0 to +100.0 0.0 Enter the value for Green 
adjustment. 

Blue –100.0 to +100.0 0.0 Enter the value for Blue 
adjustment. 

Master –100.0 to +100.0 0.0 Enter the value for linked 
Red, Green, and Blue 
adjustment.
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1 To make the gamma curve setting, use the [Gamma Adjustment] field for 
the left and right camera, or move the slider sideways or enter a numeric 
value.

 

2 To make the knee point setting, use the [Knee Adjustment] field for the left 
and right camera, or move the slider sideways or enter a numeric value.

 

Setting item Setting range Default 
setting

Description

Red –100.0 to +100.0 0.0 Enter the value for Red 
adjustment. 

Green –100.0 to +100.0 0.0 Enter the value for Green 
adjustment. 

Blue –100.0 to +100.0 0.0 Enter the value for Blue 
adjustment. 

Master –100.0 to +100.0 0.0 Enter the value for linked 
Red, Green, and Blue 
adjustment.

Setting item Setting range Default 
setting

Description

Red +20.0 to +75.0 +50.0 Enter the value for Red 
adjustment. 

Green +20.0 to +75.0 +50.0 Enter the value for Green 
adjustment. 

Blue +20.0 to +75.0 +50.0 Enter the value for Blue 
adjustment. 

Master +20.0 to +75.0 +50.0 Enter the value for linked 
Red, Green, and Blue 
adjustment.

R
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White balance adjustment

Black 
balance 
adjustment

Gamma 
adjustment

Red/Green/Blue input

Knee adjustment
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Making Waveform Monitoring Display Function 
Settings

When performing camera alignment correction, HD-SDI output is sent to the 
waveform monitoring display for monitoring the waveform from the left and 
right camera.
Settings available here control the waveform monitoring display functions, such 
as the waveform type and video signal from the camera to display, zoom area, 
waveform width, etc.
The settings are located under the [Waveform Monitoring] tab.

Waveform display examples

a Sub monitor A display
Shows the image using the output format selected with [Sub Monitor A]. (see 
page 32)

b Sub monitor B display
Shows the image using the output format selected with [Sub Monitor B]. (see 
page 32)

7 1

2

5

4

3

6

Waveform display

Depth information display
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c Zoom area display
The red (for left camera) and cyan (for right camera) rectangular regions 
indicate which part of the image will be zoomed.  (see page 56)
These rectangular regions are referred to as “zoom display regions.”

d Waveform area display
The zoom display regions configured in 3 appear in zoom display, and the red 
(for left camera) and cyan (for right camera) cross-shaped regions indicate the 
width and position of the waveform displayed in 5. (see page 57)
These cross-shaped regions are referred to as “waveform display regions.”

e Waveform display
This is shown when [Waveform] is selected for [WFM Lower Third].
Shows the waveform of the specified waveform area, obtained by scanning in 
the horizontal direction and vertical direction. Color components are shown as 
vectors.
The boxes  in the vectorscope indicate the amplitude and phase for 75% color 
bars.

The resolution of the waveform monitoring display is 480 × 270. An anti-
aliasing filter is applied to accommodate this resolution when displaying the 
HD-SDI signal. Therefore, if a sweep waveform or similar is used to measure 
frequency response characteristics, the displayed waveform will not be the same 
as the source waveform.

f Depth information display
This is shown when [Depth] is selected for [WFM Lower Third]. Depth 
information for the 3D image shown in the Zoom Area is calculated from the 
horizontal shift of the L and R signal and displayed on a monochrome image. 
The monochrome image uses the L image signal. Available display formats are 
Depth Guide which shows overall depth information, Depth Warning which 
shows only the section exceeding a specified threshold, and Depth Statistics 
which shows depth information distribution as a histogram.

• The Depth Guide and Depth Warning image is delayed with regard to other 
images.

• Under some conditions, such as when the L and R image has many flat 
sections or repetitions of similar patterns, the displayed depth information 
may not be accurate.

g Focal length value display
When [Zoom Link] is disabled, the value that appears in the [Focal Length] 
value box of the view area appears here. When [Zoom Link] is enabled, the real 
time focal length values obtained from the left and right cameras appear here. 
(see page 38)

Tip

Notes
Making Waveform Monitoring Display Function Settings
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Basic Operations Under the [Waveform Monitoring] Tab

To match the application requirements, monitoring settings for the left and right 
camera can be made either together or separately for each camera.

Displaying zoom display regions in the zoom area
Placing a check mark next to [Region] in [Zoom Area] under [Group] causes 
zoom display regions to appear in the zoom areas of the waveform monitoring 
display.

Displaying waveform display regions in the waveform area
Placing a check mark next to [Region] in [Waveform Area] under [Group] 
causes waveform display regions to appear in the waveform areas of the 
waveform monitoring display.

Selects the camera pair for 
which to make settings.

Selects the waveform 
type and trace format.

Panel for left camera waveform 
monitoring settings

Panel for right camera waveform 
monitoring settings

Panel for shared left/right camera 
waveform monitoring settings

Selects whether to display the waveform or depth information 
in the lower part of the waveform monitoring display.

Adds position lines to 
the waveform display.
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Displaying the grid
Placing a check mark next to [Grid] in [Zoom Area] or [Waveform Area] under 
[Group] causes a grid to be shown on the waveform monitoring display.

Screen example: Zoom Area

Returning a setting to the default
You can return all settings to their default values at once or reset them by 
section.

Returning specific settings to the default
Click [Reset] in the respective setting panel.
Screen example: Zoom Area

Returning all settings to the default
Click [Reset] at the top right of the [Waveform Monitoring] tab.
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Selecting the Waveform Type to be Displayed

The waveform type can be selected in the drop-down box under [Waveform].

The following waveform type settings are available.
Y Only: Display only the Y waveform.
Pb and Pr: Display the Pb waveform and Pr waveform.
Y, Pb and Pr: Display the Y waveform, Pb waveform, and Pr waveform.
G Only: Display only the G waveform.
R and B: Display the R waveform and B waveform.
R, G and B: Display the R waveform, G waveform, and B waveform.

Default setting: Y, Pb and Pr

Selecting the Camera for Which to Trace the Waveform

The camera whose waveform is to be displayed can be selected in the drop-
down box under [Trace].
Displaying the waveform for both the left and right camera often is convenient. 
However, when adjusting the optical axis, displaying only the waveform of the 
camera which is being adjusted will facilitate adjustment.

Left and Right: Trace the waveform of the left and right camera.
Left Only: Trace only the waveform of the left camera.
Right Only: Trace only the waveform of the right camera.

Default setting: Left and Right

Displaying Waveform Position Lines

You can display position lines on the waveform for use in position measuring.
To do this, place a check mark next to [Position Lines]. 

The minimum width of a position line is 1 pixel/0.5 lines in interlaced time-
base.
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Switching Between Waveform Display and Depth Information Display

The [WFM Lower Third] setting selects whether to display the waveform or 
depth information on the lower part of the waveform monitoring display.

Waveform: Display waveform.
Depth: Display depth information.

Default setting: Waveform

Making Zoom Display Settings

The zoom area size and position can be adjusted under [Zoom Area].

Setting the zoom region size
To adjust the zoom region size, use the [Size] field under [Group]. You can 
either move the slider sideways or enter a numeric value.

 

Adjusting the zoom position
After making linked settings for the left/right camera zoom position under 
[Group], fine adjustment of zoom position for the left and right camera can be 
performed separately with [Left Camera] and [Right Camera].

1 Move the sliders for [X] and [Y] under [Group] sideways or enter numeric 
values to specify the zoom position.

Setting item Setting range Default 
setting

Description

Size 1% to 100% 25% Enter the zoom area 
region size value. 
Making Waveform Monitoring Display Function Settings
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* This setting range is not supported in the current version of this software.

2 Move the sliders for [Offset X] and [Offset Y] sideways or enter numeric 
values to fine-tune the zoom position for each [Left Camera] and [Right 
Camera].

 

* This setting range is not supported in the current version of this software.

The setting range for [X] and [Offset X] as well as for [Y] and [Offset Y] is 
determined by the fact that the video size of the Zoom Area is 480 pixels 
(horizontal) by 270 lines (vertical).

Specifying the Region and Position of the Displayed Waveform

Under [Waveform Area], you can specify the region and position of the 
displayed waveform.

Specifying the region of the displayed waveform
Move the sliders for [Width X] and [Width Y] under [Group] sideways or enter 
numeric values to specify the region (cross shape) of the displayed waveform.
Higher figures mean that the waveform for a wider area is displayed. 
Consequently, with complex video such as natural images, the number of 
displayed waveform traces will increase.

Setting item Setting range Default 
setting

Description

X –240 to +240 0 Enter the zoom position 
value on the X axis. 

–160 to +160* 

Y –135 to +135 0 Enter the zoom position 
value on the Y axis. 

–90 to +90* 

Setting item Setting range Default 
setting

Description

Offset X –240 to +240 0 Enter the offset on the X 
axis with regard to the [X] 
setting.–160 to +160* 

Offset Y –135 to +135 0 Enter the offset on the Y 
axis with regard to the [Y] 
setting.–90 to +90* 

Tip
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* This setting range is not supported in the current version of this software.

The setting range for [Width X] and [Width Y] is determined by the fact that the 
video size of the waveform area is 480 pixels (horizontal) by 270 lines (vertical).

Specifying the center position of the displayed waveform
After making linked settings for the left/right camera waveform region center 
position under [Group], fine adjustment of the center position for the left and 
right camera can be performed separately with [Left Camera] and [Right 
Camera].

Screen example: Left camera waveform area

1 Under [Group], move the sliders for [X] and [Y] sideways or enter numeric 
values to specify the position of the waveform display.

 

* This setting range is not supported in the current version of this software.

Setting item Setting range Default 
setting

Description

Width X 1 to 480 100 Enter the horizontal width 
of the vertical section in 
the cross-shaped 
waveform display region.1 to 320* 

Width Y 1 to 270 100 Enter the vertical width of 
the horizontal section in 
the cross-shaped 
waveform display region.1 to 180* 

Tip

Setting item Setting range Default 
setting

Description

X –240 to +240 0 Enter the X axis position.

–160 to +160* 

Y –135 to +135 0 Enter the Y axis position.

–90 to +90* 

Waveform display region
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2 Move the sliders for [Offset X] and [Offset Y] sideways or enter numeric 
values to fine-tune the position for each [Left Camera] and [Right Camera].

 

* This setting range is not supported in the current version of this software.

The setting range for [X] and [Offset X] as well as for [Y] and [Offset Y] is 
determined by the fact that the video size of the Zoom Area is 480 pixels 
(horizontal) by 270 lines (vertical).

Setting item Setting range Default 
setting

Description

Offset X –240 to +240 0 Enter the offset on the X 
axis with regard to the [X] 
setting.–160 to +160* 

Offset Y –135 to +135 0 Enter the offset on the Y 
axis with regard to the [Y] 
setting.–90 to +90* 

Tip
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Settings to Facilitate Stereo Image Alignment

Various settings are available to make stereo image alignment on the waveform 
monitoring display easier.
These settings are found under the [Stereo Monitoring] tab.

The availability of functions under the [Stereo Monitoring] tab depends on the 
[Main Monitor], [Sub Monitor A], [Sub Monitor B], and [WFM Lower Third] 
settings at the top right of the screen.

For details, see “Function Availability List” (page 66).

Basic Operations Under the [Stereo Monitoring] Tab

Tip

Selects the camera pair for operation.
Selects whether to display the waveform or depth information 
in the lower part of the waveform monitoring display.
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Returning a setting to the default
Clicking [Reset] in a setting panel returns the respective settings to their default 
values.

Screen example: Floating Window

Cropping the Image Edges

You can crop unneeded parts of one image at the edge, so that L and R images 
show the same content. The required cropping amount will differ, depending on 
the excess portion.

1 Under [Left] in the [Floating Window], place a check mark to specify the 
image from the left camera to crop.

Left Camera: Crop image of left camera at OUT 1 connector.
Stereo Monitor: Crop image of left camera at OUT 3 connector.

2 Under [Left], move the sliders for [Left Edge] and [Edge Width] sideways 
or enter numeric values to specify the position and width of the left edge.
 

3 Under [Right], place a check mark to specify the image from the right 
camera to crop.

Right Camera: Crop image of right camera at OUT 2 connector.
Stereo Monitor: Crop image of right camera at OUT 3 connector.

1 2 3 4

Setting item Setting range Default 
setting

Description

Left Edge 0.00 to 10.00 0.00 Enter the left edge 
position value for 
cropping.

Edge Width 0.00 to 2.00 0.20 Enter the processing 
value (softness) for the 
left edge after cropping.
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4 Under [Right], use [Right Edge] and [Edge Width] for [Right] to crop the 
edges of the right camera image.
 

Displaying the Grid for Measuring Shift

The [Disparity Grid] setting can be used to display a grid or ruler on the main 
monitor or sub monitor. This makes it easier to assess the amount of shift 
between the left and right camera image. The grid is shown using broken lines.

Showing a grid on the main monitor
Place a check mark next to [Grid] for [Main Monitor] and select the grid type 
and spacing.

 

Showing a grid on the sub monitor
Place a check mark next to [Grid] for [Sub Monitor A] or [Sub Monitor B] and 
select the grid type.
Screen example: Sub Monitor A

Setting item Setting range Default 
setting

Description

Right Edge 90.00 to 99.99 99.99 Enter the right edge 
position value for 
cropping.

Edge Width 0.00 to 2.00 0.20 Enter the processing 
value (softness) for the 
right edge after cropping.

Setting item Setting range Default 
setting

Description

Type Ruler, Full Ruler Select the type of grid to 
display. When [Ruler] is 
selected, only a ruler-like 
scale is shown. Selecting 
[Full] causes vertical grid 
lines to be shown on the 
entire screen.

Spacing 0.5 to 10.00 (in 
0.5 increments)

3.0 Move the slider or select 
a numeric value to 
specify the grid or ruler 
spacing.
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The grid spacing will be the same as set with the [Spacing] option for the [Main 
Monitor].

Adjusting the Depth Range for a 3D Image

When adjusting the camera positions, the [Depth Budget] setting can be used to 
set the maximum values for near-range and far-range parallactic angle, to 
control the depth range of the 3D image. 

Relation between depth information display and [Depth Budget]
The Depth Guide indication on the waveform monitoring display shows the 
distribution of near range to far range, and the Depth Warning shows sections 
that exceed the range specified in Depth Statistics with color coding, using 
yellow to red (near range) and blue (far range). The [Depth Budget] enables you 
to set parallactic values suitable for the content to create, taking the horizontal 
screen size as 100 percent and specifying allowable settings for the near range 
and far range.

1 Select [Depth] for [WFM Lower Third].

The lower part of the waveform monitoring display shows depth 
information. 
Next, use [Depth Budget] to set maximum values for near range and far 
range.

Setting item Setting range Default 
setting

Description

Type Ruler, Full Ruler Select the type of grid to 
display. When [Ruler] is 
selected, only a ruler-like 
scale is shown. Selecting 
[Full] causes the grid and 
ruler to be shown.

Tip

Shown in color specified with 
[Disparity Key] when range 
specified with [Depth Budget] 
is exceeded.

[Depth Budget] serves to control the range 
by specifying maximum values for near 
range and far range.

Depth information distribution 
is shown in the color specified 
with [Disparity Key].
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2 Select whether to use percent or pixels as display unit for Depth Statistics 
on the waveform monitoring display.

The value specified here is reflected in the Depth Statistics display on the 
waveform monitoring display.

3 Use [Near] to specify the maximum value for the near range, and [Far] to 
specify the maximum value for the far range in 0.25-percent increments.
 

Percent values are converted into pixels for display in the [Pixel] value 
fields.

Adjusting the Left and Right Camera Image Position (Split Screen)

With [Split Screen] you can shift the position where the left and right camera 
images are split, or flip one of the images.

Setting item Setting range Default 
setting

Description

Near –10.00 to 0.00 (in 
0.25 increments)

–3.00 Select the maximum 
value for the near range.

Far 0.00 to 10.00 (in 
0.25 increments)

3.00 Select the maximum 
value for the far range.

Tip

2 3

Left camera image Right camera image

Shifting the split position (Position)

Offset

Position Position + Offset
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Adjusting the Checkerboard

Move the sliders under [Checkerboard] sideways or enter numeric values to 
specify the size and position of the checkerboard tiles.

Setting item Setting range Default 
setting

Description

Flip Off, Flip Left, Flip 
Right 

Off Flip the left or right camera image. 
Off: No image flip
Flip Left: Flip the left camera image.
Flip Right: Flip the right camera 
image. 

Position 0.00 to 99.99 50.00 Move the slider or enter a numeric 
value to specify the split position.

Offset –20.00 to +20.00 0.00 Offset the right camera image. 
Move the slider or enter a numeric 
value to specify the offset position.

Flipping the left or right camera image

Flip Left Flip Left + Offset

Flip Right Flip Right + Offset
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Function Availability List

The availability of functions under the [Stereo Monitoring] tab depends on the 
[Main Monitor], [Sub Monitor A], [Sub Monitor B], and [WFM Lower Third] 
settings at the top right of the screen.

Yes: Available, Blank: Not available

The signal of the OUT 1, 2 connectors of the MPE-200 unit (HD-SDI video 
output) is available only for [Floating Window].

Setting item Setting range Default 
setting

Description

Tile 2 to 96 32 Enter the tile size value.

Offset –20.00 to +20.00 0.00 Offset the right camera image. 
Enter the offset position value.

Setting item at screen top right
Settings under [Stereo Monitoring] tab

Floating 
Window Disparity Grid Depth Budget Split Screen Checkerboard

Main Monitor Side by Side Yes Yes

Above Below Yes Yes

Left Only Yes

Right Only Yes

Anaglyph Yes

50% Mix Yes

Difference Yes

Difference Y Yes

Checkerboard Yes

Split Screen Yes

Sub Monitor 
A, B

Anaglyph Yes

50% Mix Yes

Difference Yes

Difference Y Yes

Checkerboard Yes

Split Screen Yes

WFM Lower 
Third

Waveform

Depth Yes

Tip
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What Is a Setup File?

A setup file is a file containing information about settings for the SIP GUI 
software. It is used during startup of the MPE-200 unit. You can have multiple 
setup files and use them as required in different situations.

The setup file stores information about settings made under the following tabs.
• System (only the [Signal Source] setting under [Gen. Lock])
• Camera Alignment
• Color Correction
• Waveform Monitoring
• Stereo Monitoring
• Convergence (Auto Offset, Auto Scale, Focal Length)

• The following setup files are provided by default. 
If [Ref. Video] is selected for [Signal Source] under [Gen Lock] in the 
[System] tab, input the reference signals indicated in the following table.

 

Tips

File name Format (resolution/
frequency/scan format)

Reference signal

default_1080PsF_23_98 1920 × 1080, 23.98 Hz, 
PsF

HD Tri Sync, 47.95 Hz

default_1080PsF_24 1920 × 1080, 24 Hz, PsF HD Tri Sync, 48 Hz

default_1080PsF_25 1920 × 1080, 25 Hz, PsF HD Tri Sync, 50 Hz / 
B.B, 50 Hz

default_1080PsF_29_97 1920 × 1080, 29.97 Hz, 
PsF

HD Tri Sync, 59.94 Hz / 
B.B, 59.94 Hz

default_1080i_50 1920 × 1080, 50 Hz, 
Interlaced

HD Tri Sync, 50 Hz / 
B.B, 50 Hz

default_1080i_59_94 1920 × 1080, 59.94 Hz, 
Interlaced

HD Tri Sync, 59.94 Hz / 
B.B, 59.94 Hz
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• When you start the software, the name of the setup file used will appear as 
“- [File Name]” after “Stereo Image Processor” in the title bar. 
However, “- [non title]” will appear if a default setup file is used to start up 
the software.
“- [non title]” will also appear when creating new setups (regardless of 
whether [Save] or [Non Save] is used). (see page 69)
If an MPE-200 unit is not connected, the space for the file name will be blank.

• The setup file used at startup can be changed by accessing the [File] menu and 
selecting [Manage Setup Files].

For information on the setup file used at startup, see “Changing the System 
Mode” (page 28).

• Setup files for software versions 1.0 and 1.1 are not compatible with each 
other. Therefore, setup file names for version 1.0 will not appear in the lists of 
the “Save Setup Data” and “Manage Setup Files” dialog boxes.
What Is a Setup File?
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Saving Setup Files

This section describes how to create a new setup and store the settings in a setup 
file.

• The most recently saved setup file will automatically be used at startup.
• The settings (Except Auto Offset and Auto Scale) under the [Convergence] 

tab can be saved by using the Snapshot function (see page 78). The [Focal 
Length] setting under the [Convergence] tab is saved both in the setup file and 
the Snapshot. The most recent setting has priority.

Creating a New Setup

When the MPE-200 unit starts up, it uses a setup file that has been specified for 
startup. To create a new setup, you must clear the currently established settings 
and then establish new settings to be saved in a setup file.

1 Click the camera pair number for which you want to create a setup file.

2 Access the [File] menu and select [New Setup].

The “Save Setup Data” dialog box appears.

3 Click [Non Save].

The settings saved in the setup file are cleared, and the dialog box closes.

If you want to save the setup you are about to create before making settings, 
enter a name in the [Enter Setup Name] field, and then click [Save].

Tips

Tip
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4 Make the required settings under the [System] tab, [Camera Alignment] tab, 
[Waveform Monitoring] tab, and [Color Correction] tab.

When all required settings have been established, proceed to “Saving the 
Current Settings as a Setup File” (page 70).

Saving the Current Settings as a Setup File

To save the current settings of the [System setup] tab, [Camera Alignment] tab, 
[Color Correction] tab, [Waveform Monitoring] tab, and [Stereo Monitoring] 
tab as a setup file, proceed as follows.

1 Access the [File] menu and select [Save Setup Data].

The “Save Setup Data” dialog box appears.

The [Enter Setup Name] field shows the same file name as shown in the title 
bar. Even if this file name is used and the old file will be overwritten, no 
overwrite warning message will be shown.

2 Enter a name of up to 20 alphanumeric for the setup file in the [Enter Setup 
Name] field, and then click [Save].

The setup file is saved.

Tip
Saving Setup Files
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Deleting Setup Files

To delete a saved setup file, proceed as follows.

1 Click the camera pair number for which you want to delete a setup file.

2 Access the [File] menu and select [Manage Setup Files].

The “Manage Setup Files” dialog box appears.

3 Select the setup file to delete, and click [Delete].

The setup file is deleted.

• The default setup files cannot be deleted.
• If the setup file that was used at startup is deleted, one of the default setup 

files will be used instead of it.

Tips
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C3D Image Tuning
Adjusting the 3D Image Appearance

The final appearance of the 3D image produced by the video signal from the left 
and right camera can be modified by digital signal processing. The adjustment 
results can be saved in a Snapshot and recalled later.
3D image appearance settings are made under the [Convergence] tab, which 
also allows saving and recalling settings.

Basic Operations Under the [Convergence] Tab

The view area provides a preview that allows you to check the effect of settings.

Selects the camera pair for which to make settings.

View area
Adjusting the 3D Image Appearance
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Using the view area

a Focal Length
Read the focal length from the zoom ring on the lens of the camera in use and 
specify this value.
When you click [Position 1] or [Position 2], the focal length specified with 
[Zoom Position 1] and [Zoom Position 2] under the [System] tab is set in the 
input field.
To enter a focal length other than the preset values, enter a numeric value in the 
range from 0.1 mm to 500.0 mm.

If the [Toe-In Angle] setting of [Convergence] in the [Convergence] tab, or any 
one of the [Translate X], [Translate Y], [Tilt], or [Toe-In] settings in the 
[Camera Alignment] tab are set to a value other than the default value of 0, the 
value configured here will have an effect on the output results.

b Zoom Link
Using the focal length information obtained from the camera, the camera 
alignment can be corrected automatically according to the zoom setting.

• When a check mark is placed next to [Zoom Link], the numeric value input 
for 1 [Focal Length] has no effect. When the [Zoom Link] check mark is 
removed, the most recently obtained focal length value will be entered as 
[Focal Length].

• Placing a check mark next to [Auto Offset] or [Auto Scale] will also activate 
a check mark next to [Zoom Link]. When the [Zoom Link] check mark is 
removed, the [Auto Offset] and [Auto Scale] check marks will also be 
removed automatically.

• For information on lenses and cameras supporting the Zoom Link function, 
please contact a Sony service representative or dealer.

c Auto Size
When performing camera alignment, it may happen that a section without image 
(blanking section) becomes visible. This function performs enlargement so that 
the blanking section will not be shown.
When the parameters for the left (right) camera are changed, the image from the 
other camera may also be affected.
Place a check mark in the box to enable automatic size correction.
When the check mark is removed, [Auto Size] enlargement is not carried out, 
and the size is controlled by the [Manual Size] value as entered under the 
[Camera Alignment] tab.

1 2

4

Top View Side View Rear View

3

Tip

Tips
73Adjusting the 3D Image Appearance



74

  C
hapter 6  3D

 Im
age Tuning
d View area
There are three angles provided by the camera model: Top View, Side View, 
and Rear View. (The indication from left is Top View, Side View, Rear View.) 
The view area makes it possible to check how the various parameter setting 
values affect the respective camera model. If you place a check mark next to 
[Zoom Link], the affect is not reflected. The degree of change is about three 
times the actual setting. 

Locking the settings
The current settings can be locked by placing a check mark next to [Lock] in the 
respective panel.
Screen example: Vertical Adjustment

The [Lock] function is only intended to prevent accidental changing of 
configured settings. Information regarding whether this function is enabled is 
not saved to Snapshots or setup files. Except for certain settings, setting values 
will return to default values when you execute [Reset to Default Values], 
regardless of whether the lock function is enabled.

Returning a setting to the default
Clicking [Reset] in a setting panel returns the respective settings to their default 
values.
Screen example: Horizontal Offset

Tip
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Adjusting the Horizontal Offset

In the [Horizontal Offset] panel, move the [Planar Shift H] slider sideways or 
enter a numeric value to adjust the horizontal offset.
When a slider is moved or a numeric value is entered, the image from the left 
and right camera moves in the opposite direction on the horizontal plane, 
resulting in a change in perspective.
This makes it possible to specify an object in the image for which there is no 
left/right disparity. By placing a check mark next to [Auto Offset] before 
adjusting the offset, left/right disparity of the specified object will be prevented 
even when zooming.

 

• [Auto Offset] and [Zoom Link] are linked. Placing a check mark next to [Auto 
Offset] will also activate a check mark next to [Zoom Link]. When the [Zoom 
Link] check mark is removed, the [Auto Offset] check mark will also be 
removed automatically.

• For information on lenses and cameras supporting the Auto Offset function, 
please contact a Sony service representative or dealer.

If focal length information has not been received from the camera, perform 
adjustments with the check mark removed.

Adjusting 3D Image With Toe-in Angle

The [Toe-In Angle] setting under [Convergence] lets you adjust the appearance 
of a 3D image shot with a toe-in angle.

You can either move the slider sideways or enter a numeric value to adjust the 
toe-in angle between the cameras.
The images from the left and right camera are transformed along the toe-in angle 
axis by the same amount but in opposite directions.

 

Setting item Setting range Default 
setting

Description

Planar Shift H –200.0 pixels to 
+200.0 pixels

0.0 
pixels

Offsets left/right camera 
image on horizontal axis 
by same amount in 
opposite direction.

Tips

Note

Setting item Setting range Default 
setting

Description

Toe-In Angle –10.0 degrees to 
+10.0 degrees

0.0 
degrees

Offsets left/right camera 
image on toe-in angle 
axis by same amount in 
opposite direction.
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When [Auto Size] is selected and the [Toe-In Angle] setting is large, the image 
will be excessively enlarged and the toe-in angle adjustment effect will not be 
very noticeable.

Correcting Zoom Shift

This setting corrects for left/right camera zoom ratio differences.

In the [Zoom Scale Adjustment] panel, move the sliders for the cameras 
sideways or enter a numeric value to correct zoom ratio differences. 
When a check mark is placed next to [Auto Scale], the focal length information 
from the camera is used to automatically adjust the size of the left and right 
camera image.

• If focal length information has not been received from the camera, perform 
adjustments with the check mark removed.

• Automatic correction will only have an effect when there is a difference in 
size between the left and right image, and this difference is reflected in the 
camera focal length. If there is not effect, perform adjustments with the check 
mark removed.

 

• [Auto Scale] and [Zoom Link] are linked. Placing a check mark next to [Auto 
Scale] will also activate a check mark next to [Zoom Link]. When the [Zoom 
Link] check mark is removed, the [Auto Scale] check mark will also be 
removed automatically.

• For information on lenses and cameras supporting the Auto Scale function, 
please contact a Sony service representative or dealer.

Note

Notes

Object

Setting item Setting range Default 
setting

Description

Left 0.010× to +5.000× 1.000× Corrects left camera shift. 

Right 0.010× to +5.000× 1.000× Corrects right camera shift.

Tips
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Fine-Adjusting the Height

If there has been a shift in camera height correction after making the [Camera 
Alignment] tab settings, a final correction is possible with this setting.
If the rig was moved to a different position or if the left/right camera inter-axes 
distance or toe-in angle was changed, the settings under the [Camera 
Alignment] tab normally have to be changed. However, if pressed for time, the 
[Vertical Adjustment] panel provides a quick way to make an emergency 
adjustment.

You can either move the sliders sideways or enter numeric values. To perform 
the adjustment for both cameras together, use the [Combination] setting.

 

* Number of lines in frame

As [Left] and [Right] values are saved with the snapshot function, they can be 
accurately recalled when a snapshot is recalled. When the [Left] and [Right] 
values are adjusted and balance is lost, the [Combination] value that is displayed 
should not be used as a reference.

Setting item Setting range Default 
setting

Description

Left –100.0 lines* to 
+100.0 lines* 

0.0 lines* Adjusts left camera height. 

Combination –100.0 lines* to 
+100.0 lines* 

0.0 lines* Moves both the left and right 
camera and adjusts height.

Right –100.0 lines* to 
+100.0 lines* 

0.0 lines* Adjusts right camera height. 

Tip
77Adjusting the 3D Image Appearance
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What Is a Snapshot?

A Snapshot is a function to save when the settings under the [Convergence] tab 
have been changed, for example for different camera angles. By saving 
convergence settings as a snapshot, you can easily return to a given condition 
later, as required.

Making Snapshot Settings

Adjustments made in the [Convergence] tab can be saved as a snapshot in a 
folder that you specify.

Creating the Snapshot Save Folder

A Snapshot is saved in a specific area of the MPE-200 unit’s hard disk (called 
the root folder in this application). However, it is possible to create folders 
within this area for storing Snapshots. Snapshots for certain operations can be 
collected in dedicated folders, and a default folder can be specified for 
frequently used files.

1 Click the camera pair number for which you want to create a folder.

2 Display the [Convergence] tab and click [Manage Folders] in the 
[Snapshot] section.

The “Manage Snapshot folders” dialog box appears.
What Is a Snapshot? / Making Snapshot Settings
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3 Enter a name of up to 20 alphanumeric for the folder in the [Enter New 
Folder Name] field, and then click [Create New Folder].

The folder is created and added to the list.

4 To specify a folder as the default folder, select it and click [Set to Use].

The selected folder becomes the default folder, and the indication 
“(default)” appears after the folder name.

• Default folder selections are not stored. Select a default folder each time 
you start up the SIP GUI software.

• You can create up to 10 folders.

5 Click [Close] to close the dialog box.

Tips
79Making Snapshot Settings
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Saving a Snapshot

You can save the result of adjusting the [Convergence] settings* in a Snapshot 
as follows.
* Information about whether settings are locked is not saved.

• One folder can contain up to 20 Snapshots.
• The [Focal Length] setting under the [Convergence] tab is saved both in the 

Snapshot and in the setup file. The most recent setting has priority.

1 After adjusting settings under the [Convergence] tab, click [Save] in the 
[Snapshot] section.

The “Save Snapshot” dialog box appears.

2 Use [Folder] to select the Snapshot save folder.

3 Enter a name of up to 20 alphanumeric for the Snapshot in the [Enter 
Snapshot Name] field and click [Save].

To overwrite an existing Snapshot, you can click its file name, so that it 
appears in [Enter Snapshot name] field.

The Snapshot is saved.

Tips
Making Snapshot Settings
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Recalling a Snapshot

You can recall a snapshot in two ways. Select the method that is more 
convenient.
• Recall the Snapshot while making 3D image adjustments ([Convergence] 

tab).
• Recall the Snapshot while live production at an event (Shot Box).

The method using the [Convergence] tab is described below.

For information on the Shot Box method, see “Chapter 8  Shot Box” (page 84).

1 Display the [Convergence] tab and click [Recall] in the [Snapshot] section.

The “Recall Snapshot” dialog box appears.

2 Under [Folder], select the folder where the Snapshot has been saved.

When you select a folder, a list of Snapshots present in that folder appears.

3 Select the Snapshot from the list and click [Recall].

The selected Snapshot is recalled.
81Recalling a Snapshot
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• If “(in memory)” is displayed for a Snapshot, the Snapshot is cached in 
memory and can be recalled quickly. Snapshots for which “(in memory)” 
is not displayed must be copied into memory first and therefore take 
longer to load.

• As [Left] and [Right] values are saved with the snapshot function, they 
can be accurately recalled when a snapshot is recalled. When the [Left] 
and [Right] values are adjusted and balance is lost, the [Combination] 
value that is displayed should not be used as a reference.

• Snapshot data will be recalled, even for setting values that have been 
locked.

Tips
Recalling a Snapshot
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Deleting a Snapshot

You can delete a saved Snapshot and Snapshot folder as follows.

1 Access the [File] menu and select [Configure Shot Box].

The “Configure Shot Box” dialog box appears.

2 From the [Snapshots] list, select the Snapshot you want to delete, and click 
[Delete].

By holding down the Shift key or Ctrl key, you can select multiple 
Snapshots.

A confirmation message appears.

3 Click [Yes].

The selected Snapshot is deleted.

• When you delete a Snapshot, the same Snapshot registered in the Shot 
Box is also deleted automatically.

• Using the same procedure as for Snapshots, you can also delete a 
Snapshot folder. However, it is not possible to select and delete multiple 
Snapshot folders. Deleting a Snapshot folder will also delete all Snapshots 
in the folder. If such a folder is selected as default folder, Root will 
become the new default folder.

4 Click [Close] to close the dialog box.

Tips
83Deleting a Snapshot
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What Is the Shot Box?

The Shot Box function allows you to recall Snapshots during recording with a 
single click. Snapshots for each camera pair should be registered in the Shot Box 
beforehand.

For information on Snapshots, see “Chapter 7  Snapshots” (page 78).

To use the Shot Box function, you must 
first switch to Shot Box mode.

The typical settings stored in the Snapshot are displayed.

This brings up a 
display of Snapshots 
registered for the 
currently connected 
camera pair.

You can change the order in which 
Snapshots are displayed. (see page 87)
What Is the Shot Box?
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Registering a Snapshot in the Shot Box

In the Shot Box for each camera pair, you can register and recall up to 20 
Snapshots.

For information on recalling a Snapshot, see “Using the Shot Box” (page 88).

Registering a Snapshot in the Shot Box

1 Click [Setup] to switch to setup mode.

2 Click the camera pair number for which you want to register a Snapshot.

3 Access the [File] menu and select [Configure Shot Box].

The “Configure Shot Box” dialog box appears.

4 From the [Snapshots] list, select the Snapshot you want to register, and click 
[>>].

Clicking [Resume] displays previously saved configurations. 
Configurations are saved when you shut down the SIP GUI software, or 
when you click [Close] in the “Configure Shot Box” dialog box. (This 
process requires some time.) To cancel the process before it is finished, 
click [Cancel].

The selected Snapshot is added to the [Shot Box] list.
85Registering a Snapshot in the Shot Box
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• The same Snapshot can be added multiple times.
• Up to 20 Snapshots can be registered.
• If you select multiple Snapshots and register them to the Shot Box at one 

time, it may require some time before the file names appear in the list.
• It is also possible to register a Snapshot for which “(in memory)” is not 

displayed in the Shot Box.

5 Click [Close] to close the dialog box.

6 Click [Shot Box] to switch to Shot Box mode.

The registered Snapshots are shown.

• Snapshots are shown in the order of the [Shot Box] list in the “Configure 
Shot Box” dialog box.

• The list shows Snapshots that are currently registered in the Shot Box. 
Deleted Snapshots will not be shown.

To change the order, see the section “Changing the Snapshot order” (page 
87).

The registered content (file selection and sequence information) will be 
cleared when exiting the SIP GUI software. To call up the settings that were 
active when the SIP GUI software was last shut down, click [Resume] as 
described in step 4. 

Tips

Tips

Note
Registering a Snapshot in the Shot Box
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Changing the Snapshot order
You can change the order of the Snapshots in the Shot Box by using drag & 
drop.

Removing a Snapshot from the Shot Box

1 Click the camera pair number for which you want to remove a Snapshot.

2 Access the [File] menu and select [Configure Shot Box].

The “Configure Shot Box” dialog box appears.

3 Select the Snapshot to remove from the [Shot Box] list, and click [Remove].

The selected Snapshot is removed from the [Shot Box] list.

4 Click [Close] to close the dialog box.

Grasp this section with the mouse and drag it to the desired position.
87Registering a Snapshot in the Shot Box
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Using the Shot Box

On the “Shot Box” screen, you can recall a Snapshot for a camera pair by 
clicking the Snapshot on the line for the camera pair.
For example, to recall a Snapshot for camera pair 1, click the Snapshot on the 
[Camera Pair 1] line.

Camera pair 1 
Snapshot

Click here to recall the Snapshot.
Using the Shot Box
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